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JMeter non-Gui Mode :
Why running loading test in non-gui mode?
JMeter is twice working mode:  GUI(Graphical User Interface)which permit to create, write a script and run a loading test and non-GUI mode which permit  only to run script of loading test.

Why non-GUI mode? Because in that mode, JMeter may be embarrassed by the graphic management when running loading tests. And this can influence the quality of the results.

Concerning the graphic mode it has influences on :
· The processor. JMeter has to deal with 2 points: the loading test (sending requests, receiving responses, possibly write in a file, and so on…) and the display of the results in the listeners with some statistic counts (average, total, etc). The power of the processor is separated into two main tasks: the test, and the display.

· La memory. Some listeners, such as result tree and aggregate report, consume a lot of resources, indeed, for each sample test, memory is used. So, when a test generate a lot of requests a lot of memory  is used, which can lead you to OutOfMemoryError if you don’t rise the maximal memory of the JVM of  JMeter (in the launch script).
· One more thing, the JVM (which execute JMeter will have to the garbage collector to manage de memory during the identification of the object to erase from the memory, so the treatment of  the results will last longer, because all the tread will be frozen.
To conclude, GUI-mode is to avoid for loading test, even if it’s a simple one because we might have wrong results in term of computing and response time. The GUI-mode is to use to create and maintain JMeter scripts and run one thread test to verify your test works.
Optimization tip:

If your machine has a multi core CPU use the last version of java (6), because all the threads will use all CPU available on JMeter.
For non-interactive testing, you may choose to run JMeter without the GUI. To do so, use the following command options 

-n This specifies JMeter is to run in non-gui mode 

-t [name of JMX file that contains the Test Plan]. 

-l [name of JTL file to log sample results to]. 

-r Run the test in the servers specified by the JMeter property "remote_hosts" 
-R [list of remote servers] Run the test in the specified remote servers 

The script also lets you specify the optional firewall/proxy server information: 

-H [proxy server hostname or ip address] 
      -P [proxy server port] 

Example : JMeter -n -t my_test.jmx -l log.jtl -H my.proxy.server -P 8000 

Here is the rest of the parameter available:

        -h, --help

                print usage information and exit

        -v, --version

                print the version information and exit

        -p, --propfile {argument}

                the JMeter property file to use

        -q, --addprop {argument}

                additional property file(s)

        -t, --testfile {argument}

                the JMeter test(.jmx) file to run

        -j, --JMeterlogfile {argument}

                the JMeter log file

        -l, --logfile {argument}

                the file to log samples to

        -n, --nongui

                run JMeter in nongui mode

        -s, --server

                run the JMeter server

        -H, --proxyHost {argument}

                Set a proxy server for JMeter to use

        -P, --proxyPort {argument}

                Set proxy server port for JMeter to use

        -u, --username {argument}

                Set username for proxy server that JMeter is to use

        -a, --password {argument}

                Set password for proxy server that JMeter is to use

        -J, --JMeterproperty {argument}={value}

                Define additional JMeter properties

        -G, --globalproperty (argument)[=(value)]

                Define Global properties (sent to servers)

                e.g. -Gport=123

                 or -Gglobal.properties

        -D, --systemproperty {argument}={value}

                Define additional System properties

        -S, --systemPropertyFile {filename}

                a property file to be added as System properties

        -L, --loglevel {argument}={value}

                Define loglevel: [category=]level 

                e.g. jorphan=INFO or JMeter.util=DEBUG

        -r, --runremote (non-GUI only)

                Start remote servers (as defined by the JMeter property remote_hosts)

        -R, --remotestart  server1,... (non-GUI only)

                Start these remote servers (overrides remote_hosts)

        -d, --homedir {argument}

                the JMeter home directory to use

        -X, --remoteexit

                Exit the remote servers at end of test (non-GUI)

Follow a loading tests in non-gui mode with statics
A question may appear while running tests: Is everything going properly? Is there any errors? A dead lock? Hopefully JMeter provided for an option which will give us pieces of information during the test.
It is « summariser », which will regularly display statistics of the running. Here is an example:
summary +   200 in  30.0s =    6.7/s Avg:    13 Min:     8 Max:    53 Err:     0 (0.00%)
summary =  1448 in 225.0s =    6.4/s Avg:    13 Min:     6 Max:    67 Err:     0 (0.00%)
The first line tells us that since the last display, 200 samples where run during the last 30 seconds. So it does 6.7 samples a second. The average of response time is 13 ms; the minimum was 8ms and the maximum 53ms; no errors detected during the period.

The second line gives us the same types of date but from the beginning of the launch.
To activate this option, edit the JMeter.properties.
JMETER_HOME/bin/JMeter.properties au niveau des paramètres suivants :

#---------------------------------------------------------------------------

# Summariser configuration (mainly applies to non-GUI mode)

#---------------------------------------------------------------------------

# Summariser settings

#

# Define the following property to automatically start a summariser with that name

# (applies to non-GUI mode ony)

#summariser.name=summary

#

# interval between summaries (in seconds) default 3 minutes

#summariser.interval=180

#

# Write messages to log file

#summariser.log=true

#

# Write messages to System.out

#summariser.out=true

Do a copy/past of those elements, and put it in the user.properties (in the same directory), and modify them as you want.
For instance:
#---------------------------------------------------------------------------

# Summariser configuration (mainly applies to non-GUI mode)

#---------------------------------------------------------------------------

# Summariser settings

#

# Define the following property to automatically start a summariser with that name

# (applies to non-GUI mode ony)

summariser.name=summary
#

# interval between summaries (in seconds) default 3 minutes (180)

summariser.interval=30
#

# Write messages to log file (JMeter.log)
summariser.log=false
#

# Write messages to System.out

summariser.out=true
Here you are. Let’s have look at the output:
:~/opt/jakarta-JMeter-2.3.2/bin$ JMeter -n -t ./Simple.jmx -l ./resultats.csv

Creating summariser

Created the tree successfully using Simple.jmx

Starting the test @ Sun Feb 01 08:45:44 WET 2009 (1233477944841)

summary +    49 in  15.0s =    3.3/s Avg:    15 Min:     6 Max:    67 Err:     0 (0.00%)

summary +   199 in  30.0s =    6.6/s Avg:    14 Min:     8 Max:    60 Err:     0 (0.00%)

summary =   248 in  45.0s =    5.5/s Avg:    15 Min:     6 Max:    67 Err:     0 (0.00%)

summary +   200 in  30.0s =    6.7/s Avg:    14 Min:     9 Max:    52 Err:     0 (0.00%)

summary =   448 in  75.0s =    6.0/s Avg:    14 Min:     6 Max:    67 Err:     0 (0.00%)

[......]

summary +   200 in  30.0s =    6.7/s Avg:    12 Min:     8 Max:    51 Err:     0 (0.00%)

summary =  3848 in 585.0s =    6.6/s Avg:    13 Min:     6 Max:   219 Err:     0 (0.00%)

summary +   152 in  30.1s =    5.0/s Avg:    13 Min:     8 Max:    51 Err:     0 (0.00%)

summary =  4000 in 615.2s =    6.5/s Avg:    13 Min:     6 Max:   219 Err:     0 (0.00%)

summary =  4000 in 615.2s =    6.5/s Avg:    13 Min:     6 Max:   219 Err:     0 (0.00%)

Tidying up ...    @ Sun Feb 01 08:56:00 WET 2009 (1233478560189)

... end of run

JMeter Distributed Testing Step-by-step
So know we need to run distributed testing.
 Before we start, there are a couple of things to check.

1) The firewalls on the systems are turned off.
2) All the clients are on the same subnet.
3) The server is in the same subnet, if 192.x.x.x or 10.x.x.x ip addresses are used. If the server doesn't use 192 or 10 ip address, there shouldn't be any problems.
4) Make sure JMeter can access the server.
5) Make sure you use the same version of JMeter on all the systems. Mixing versions may not work correctly.

Once you've made sure the systems are ready, it's time to setup remote testing. The tutorial assumes you already have JMeter installed on all the systems. The way JMeter works is 1

master controller initiates the test on multiple slave systems.

[image: image1.emf]
Terminology

Before we dive into the step-by-step instructions, it's a good idea to define the terms and

make sure the definition is clear.
· Master – the system running JMeter GUI, which controls the test.
· Slave – the system running JMeter-server, which takes commands from the GUI and send.
· requests to the target system(s).
· Target – the webserver we plan to stress test.
[image: image2.emf]
Step-by-Step

1) On the slave systems, go to JMeter/bin directory and execute JMeter-server.bat (JMeterserver on unix). On windows, you should see a dos window appear with “jre\[version]\bin\rmiregistry.exe”. If this doesn't happen, it means either the environment settings are not right, or there are multiple JRE installed on the system.
Note: [version] would be the jre version installed on the system.

a) Open JMeter-server.bat in a text editor.
b) Go to line 44 and find “:setCP”.
c) edit “START rmiregistry” to the full path. Example: “START

C:\j2sdk1.4.2\jre\bin\rmiregistry”.
2) On master system acting as the console, open windows explorer and go to JMeter/bin directory.
3) Open JMeter.properties in notepad or wordpad.
4) Edit the line “remote_hosts=127.0.0.1”.
5) Add the IP address. For example, if I have JMeter server running on 192.168.0.10, 11, 12,13, and 14, the entry would like this:

remote_hosts=192.168.0.10, 192.168.0.11, 192.168.0.12, 192.168.0.13, 192.168.0.14.
6) Start JMeter.
7) Open the test plan you want to use
[image: image3.emf]
Starting the Test

At this point, you are ready to start load testing. If you want to double check the slavesystems are working, open JMeter.log in notepad. You should see the following in the log.JMeter.engine.RemoteJMeterEngineImpl: Starting backing engine. If you do not see this message, it means jmeter-server did not start correctly. For tips on debugging the issue, go to the tips section. There are two ways to initiate the test: a single

system and all systems.
Start a single client
[image: image4.emf]
1) Click Run at the top.
2) Select Remote start.
3) Select the IP address.
Start all clients

[image: image5.emf]
1) Click Run at the top.
2) Select Remote start all or use CRTL-Z.
Limitations

There are some basic limitations for distributed testing. Here's the list of the known items in no specific order.
1) RMI cannot communicate across subnets without a proxy; therefore neither can JMeter without a proxy.
2) Since JMeter sends all the test results to the controlling console, it is easy to saturate the network IO. It is a good idea to use the simple data writer to save the results and view the file later with one of the graph listeners.
3) Unless the server is a large multi processor system, in most cases 1-2 clients is sufficient to overwhelm the server.
4) A single JMeter client running on a 1.4-3 GHz CPU can handle 100-300 threads depending on the type of test. The exception is web services. XML processing is CPU intensive and will rapidly consume all the CPU cycles. As a general rule, the performance of XML centric applications will perform 4-10 slower than applications using binary protocols.
Tips
In some cases, the firewall may still be blocking RMI traffic.
Symantec Anti Virus and Firewall
In some cases, Symantec firewall needs to be stopped from windows services.
1) Open control panel.
2) Open administrative tools.
3) Double click services.
4) Go to down to Symantec antivirus, right click and select stop.
Windows firewall
1) Open network connections.
2) Select the network connection.
3) Right click and select properties.
4) Select advanced tab.
5) Uncheck internet connection firewall.
Linux
On Suse Linux, ip chains are turned on by default. For instructions, please refer to the “remote testing” in the user manual.

JMeter Recording a test script
This short tutorial attempts to explain the exact steps for JMeter's proxy. For those new to JMeter, one easy way to create a test plan is to use the Proxy. What the proxy does is it records the requests sent to the server. JMeter's proxy currently does not support recording HTTPS. Since HTTPS is secure, the proxy is unable to decrypt the traffic and record the request parameters or cookies. There are several ways to get around this limitation. The easiest method is to use Badboy http://www.badboy.com.au/. The second option is to record in HTTP and then change the test plan to use HTTP request defaults.

Basic Proxy Instructions
1) Start JMeter with JMeter.bat on windows and JMeter.sh on unix.
2) Select “test plan” on the tree.
3) Right click on the “test plan” and add a new thread group: add -> thread group.
4) Select the thread group.
5) Right click “add -> config element -> Http Request Defaults”.
6) Protocol – enter “HTTP”.
7) Server name – enter “jakarta.apache.org”.
8) Path – leave blank.
9) Port number – enter “80”.
10) Select workbench.
11) Right click on workbench and add the Http proxy: add -> non-test elements -> Http Proxy Server.
a. Set the target controller to be the thread group.

b. Uncheck the Capture HTTP Headers.

c. Select ‘HTTP Request HTTPClient’ as the sampler type.

d. Check the ‘Retrieve All Embedded Resources from HTML Files’.

e. Target Controller – click on the drop down and select “test plan > thread group”.
f. Click the “add” button in “Patterns to include”. This will create a blank entry. An fill the field with the appropriated regexp.
g. Click the “add” button in “Patterns to exclude”. This will create a blank entry. An fill the field with the appropriated regexp.
12) Click the “start” button at the bottom.
13) Start Internet Explorer, but do not close JMeter.
Note: Make sure that the “include” and “exclude” patterns are correct. Below are some common patterns for images and types of pages.
· .* - all

· .*\.png – png images

· .*\.gif – gif images

· .*\.jpg – jpeg images

· .*\.php

· .*\.jsp

· .*\.html

· .*\.htm

· .*\.js
As a general tip, it is a good idea to set the homepage for your browser to a blank page. This way, it reduces the number of unwanted pages JMeter records during the session. It is a good idea to try the proxy with different sites and get comfortable with different filtering patterns.
14) From the tool bar, click “tools -> internet options”. This should bring up the options.

15) Select the “connection” tab.
16) Click “lan settings” button near the bottom.

17) On the connections tab, check “Use a proxy server for your LAN”. The address and port.Fields should be enabled now.

18) Address – enter “Localhost” or the IP address of your system

19) Port – enter “9090”.

20) Click “ok” button.
21) Click “ok” button again. This should return you to the browser

22) In the “Address” bar at the top, enter you server adress and hit the “enter” key.

23) Click on a few links on JMeter's page.

24) Close internet explorer and bring up the JMeter window.
Reviewing the Test Plan

Expand the thread group and there should be several samplers. At this point, the test plan can be saved as is. If you forget to add default http request settings, you will have to manually delete the server name, and port. In this sample, there aren't any default request parameters. If a particular request parameter is required by all pages, the request default is where one would add the entries.
1) Select “thread group”.
2) Right click “add -> listener -> aggregate report” to add an aggregate listener. The aggregate listener will show some basic statistics.

3) Select “thread group”.
4) Number of threads – enter “5”.
5) Ramp up Period – do not change.
6) Loop count – enter 100.
Running the Test

Before you start the test :

1. Find in the sampler something like: 
/j_acegi_security_check;jsessionid=*****************
In the ‘path’ field, replace the actual jsessionid value with ${JSESSIONID} so it should be:
/EOPS/j_acegi_security_check;jsessionid=${JSESSIONID}.

2. Add a Regular Expression Extractor to the Thread Group, like that:
a. Response Field to check: Body.

b. Reference Name: jsfViewState

c. Regular Expression: 
<input type="hidden" name="javax\.faces\.ViewState" id="javax\.faces\.ViewState" value="(.+?)" />
d. Template: $1$

e. Match No. : 0
3. For any jsf sampler, find the request parameter named javax.faces.ViewState, and replace its value to: 
${jsfViewState}.

If you don’t fallow this steps you will have errors when running your tests, because the parameter value is a specific object which may change from a session to another one.

Select “aggregate report”. As the test runs, the statistics will change until the test is done. At the end of the test, the aggregate report should look like this. While the test is running, in the upper right-hand corner, there should be a green square.

When the test is done, the box should be grey.
Tip: if there are too many jsf samplers, you can save the test plan, and edit the jmx file with a text editor that supports regex search and replace (such as jEdit), like that:

Search for: 

(?<=<stringProp name="Argument.name">javax.faces.ViewState</stringProp>\s{1,50}<stringProp name="Argument.value">).*(?=</stringProp>)

Replace with:

\${jsfViewState}

JMeter - Variabilisation of datas
Before trying the variabilisation you must know how to record a test script in JMeter.
This chapter is to make all the data set in a form in order a load test with JMeter with changing values on each occurrence. The data variabilisation is useful to simulate the diversity of the request that could be expected in a real environment. Especially cache effect (browser, persistence, ect)
The scenario
As you can see in this example you have to fill 2 fields labeled as First Name and Last Name.
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Then we click on the Submit Query button to send the data of the form.
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After being recorded, here is the JMeterisation result:
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Now, let’s check out the HTTP Request number 03, corresponding to the sending of the form [image: image9.png]lan
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We find in the parameters send with the request, ie the fields first name and last name. Those are the parameters we are going to « variabilise ».
Variabilisation of the scenario
In order to variabilise the scenario, we will start by prepare a CVS file (text with words separated by comas). This file will be the input of JMeter to include the fields’ first name and last name.
To edit this file the easiest way is by using Excel or Calc from open office. Here the first column will be the first name and the second one, the last name. For the example we will take a list of boxers, but it is very useful to make file with login and password. 
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Now the list is ready for use, it has to be saved with the CVS format, changing the type of the file from the dropdown list as shown below.
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If you use OppenOffice you can choose the char set, the delimiter of field and the text delimiter. Preferably we will choose UTF-8, the field delimiter is the coma and the field text delimiter will remain blank.
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Now our file is ready to be the input of JMeter.

Now go back to JMeter, select the Recording Controller item, and add a configuration item CSV Data Set Config.
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The CSV Data Set Config item allow to read a CVS file and to put in one or several variables, every rows of this file.
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We set the following values in the fields:

· Filename:  the absolute path and the name of the file(or only the name of the file, but the filename has to be in the JMeter classpath. For instance : JMETER_HOME/bin).

· File encoding: UTF-8 as it’s the one we chose.
· Variable Names: « PRENOM,NOM » to get in the variable PRENOM  the first name , and in the variable NOM the last name.

· Delimiter: The coma, as we use a CVS file.
· Recycle on EOF?:  Does JMeter has to go back from the beginning of the files at the end of file to variabilise the variables? (Yes in this case).
· Stop thread on EOF ?: Does the Thread Group item where the CSV Data Set Config item remain stops at the end of the file, not depending on of the number of occurrences expected?  No for us.
Now we have two variables during the execution of the loading test. Let’s use it during the run of the loading test. To do so, go to the third HTTP Request, the one who send the data to the Request Param servlet .
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In the zone Send Parameters With the Request zone, we find again the HTML names of the form fields; firstname and lastname. In the Value column, we will replace the values by the variables: ${PRENOM} and ${NOM}. The ${…} indicate to JMeter that it is a variable, and that when running, you have to replace it by the variable value.


If we go a bit further, we can verify, that the data sent are well displayed in the response. To do so, we will look for the Response Assertion item (Check response) of the HTTP Request item number 03.
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By using the Add button, we will add two Patterns to Test : ${PRENOM} and ${NOM}. If JMeter find both of them in the HTML response received, the assertion will be OK.
Running the test
Here we are, know we are ready to run the test. Select the Thread Group, chose the Thread parameters. Here only one virtual user, on a one second ramp-up, which is going to run 400 times the scenario.
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Then we run the test, pressing Ctrl + R on the key board (or le menu Run > Start), the result (below) will be available on the Summary Report item:
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We can verify that everything went properly by checking the View Results Tree item. 
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By choosing randomly a 03 request in the in the Response data tab, we find again the name of a boxer instead of the variables ${PRENOM} and ${NOM}.

And if we go to an other  03 request in the in the Response data tab, the name and the first name are different. 
remarks:
The CSV Data Set Config item convenient for this action, but there are other ways to do it, however more difficult. (in this case, the JMeter functions __CSVRead() and __StringFromFile()).

It is also possible to variablise a scenario with calculated dynamically during the running of the loaded test (for that, we will use the item Regular Expression Extractor of the Post-Processors group for this kind of case).
Tips :
JMeter has a main file of parameters, set in JMETER_HOME/bin. This file is JMeter.properties. You will find inside the parameter proxy.number.requests which allows to have an automatic numbering of the HTTP Request items, while the item HTTP Proxy is recording. Set the true value to get it and restart JMeter.
JMeter Tips and Tricks - Correlating with Regular Expressions
You will hear LoadRunner consultants preaching to the converted about the requirement to correlate data accurately. What they’re referring to, is making sure that dynamic data received by the client from the server (typically in a response body, header or url), which changes from request to request, is accurately correlated. If you don’t, you will probably ‘break’ the application logic with most obvious signs during replay being things like HTTP Server 500 errors.

In practice, correlation requirements relate to things like session ids, viewstate, cookies, date time stamps and other transactional information. So more often than not you will see this data changing following a post back or response from the server. With the introduction of AJAX calls, correlation requirements probably increase (per page) as the number of transactional requests probably increases as well.

In LoadRunner, you typically correlate data manually using the web_reg_save_param function. This in effect is a prepared statement, placed before the request that will return the data in the response you are looking for. For example, your function will specify a left and right boundary of the data that it is looking for before you make the request. Then the request is made and if a match is found, then the data is saved in a parameter which you can later call as a variable in subsequent requests. LoadRunner also has a feature called Correlation Studio which takes effect during recording of your script, using a similar approach (left and right boundaries) and then dynamically swapping corresponding matches with the variabilised data. All this is quite painful though, and whenever I’m specifying primitive left and right boundaries or using the flaky Correlation Studio I’m left wishing I could just use regular expressions …

The trick to correlating data easily with JMeter is to first know what data it is that needs correlating! Experience will make this easier as a lot of common web apps have common dynamic data requirements as already mentioned. Another trick is to always record the script twice (and diff to see differences between unique user sessions), then more often than not record 2+ iterations of an action within a single script (and diff to see differences between user transactions/actions). If you do this before anything else, and diff the results, you will save bucketloads of heartache in getting your script harnesses running, no matter which tool you choose.

But back to JMeter, once you do know what data you need to correlate, simply create a Post Processor -> Regular Expression Extractor to ‘variablize’ that data. Huh? Read on for a more detailed explanation of this.


In my following example, I have 4 dummy pages that return unique jsessionid’s for each page as follows:

  jsessionid=111_CATSNDOGS!50775& 

  jsessionid=222_BATSNCATS!021278& 

  jsessionid=333_SHEEPNGOATS!140679& 

  jsessionid=444_FISHNCHIPS!120880& 

I’ve done this to simulate the changing session information typically found in any jsp based web app. To look for a jsessionid I simply add a new Post Processor called the Regular Expression Extractor. The following screenshot shows an example:
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In the example provided, the reference name is what I can later call upon as a variable within the script, for example, ${jsessionid_trans}. The regular expression is the pattern I am looking for. Note in using a parenthesis I’m specifying a subexpression which I can get to with the match result number of n(1). If you’re new to regex, my example is equivalent to saying look for a left boundary of jsessionid= then match any character until you hit an ampersand. Even if you know nothing about regex, this will probably get you out of hot water 90% of the time. The real power in regex though is the ability to manipulate and narrow in on search results, or search for varying patterns (like telephone numbers, alphanumeric sequences and so on). I still find the Perl regular expression tutorials the best:
http://perldoc.perl.org/perlretut.html
So that’s it, you’ve found the jsessionid and to use it later on in your script, you simply call on it as a variable i.e. ~koops/test_JMeter/page2.html?value=${jsessionid}
I often find it is easier to open up your test plan (.jmx) in your favourite text editor and then use the same regular expression to search and replace all instances of that pattern with your newly set variable.

However there is a twist to all this, which I refer to as scope. You really need to understand the scope of your regular expression extractors and how they are applied. By scope I’m loosely referring to variable scope in a normal programming language (which JMeter is not). I think the best way to understand the scope of your extractors, is to identify which ‘container’ they are placed in. For a JMeter test plan, there are multiple containers you might place these extractors in:

· The overall Test Plan, which I call ‘global’ in scope.
· An individual Thread Group, which I call ‘thread’ in scope.
· An individual Transaction Controller, which I call ‘local’ in scope.
· An individual Request Sampler, which I call ‘trans’ in scope.
If you’re familiar with programming languages and scoping, then you’ll probably identify the pecking order of the scope I’ve just mentioned, from global right down to transaction level (I’ve made up a few names there). Global variables will override local variables and so on down the chain. So you need to be careful where you place your regular expression extractors and what reference (variable) names you use, as these can interfere with each other. Sometimes it is useful to limit your extractor in scope to a particular transaction, thread group or test plan.

In my example listed above, I’ve written a test plan to explore the different scopes identified. Using the debug sampler, you can see that the trans scope is limited to single request sampler, because it is added as a child element. This means the variable jsessionid_trans gets set only once. The local scope is limited to a transaction controller. I placed it before the second request sampler but not as a child to the first, to highlight how it sets the variable jsessionid_local twice (once for each request contained in that transaction controller). The thread scope is limited to the entire thread group, so you will see the jsessionid_thread variable set three times as each page is requested. The same applies to the global scope in which case the jsessionid_global variable is set on each occurrence of the pattern. I’ve also added a second thread group with its own debug sampler to highlight how only global variables are accessible by this thread group. Check out the results as shown below:
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Finally, here are some example regular expressions which have worked well for me for different types of web apps:

jsessionid=(.+?)&
jsessionid=(.+?)'
id="__VIEWSTATE" value="(.+?)"
jsd=(\d+)
strEntry=(.+?)'
CdzSession' value='(.+?)'
WebiSession' value='(.+?)'
DOCTOKEN VALUE='(.+?)'
etc ...
Assertions 

Once you have well organized your tests, you need for them to be helpful, to know if the responses expected occurred well.  To do so, JMeter provided for Assertion. Assertion are hypothesizes that you make about the result. If the result doesn’t match with what you expected, a failure will pop up -nothing in the other case-.
Here are the main Assertions you need. There are some more, but you will need it quite rarely. If you need them right click help on the Assertion you need to use.

Response Assertion

       Response assertions are to match a pattern in the response from the server. For example you can check if the response code is 200 as expected. To do so,
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Right click on the element you want to focus on, then Add->Assertions->Response Assertion.
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On the picture shown below the value of the Response Code is checked. However you can also match specific data from the text response the URL -if you are interested in get parameter values- Response Header. 

The pattern matching rules is more or less restrictive depending on the one you choose:
· Contains means that there is a least one occurrence of the pattern in the response.

· Matches mean that the whole response matches the pattern.

· Equals means the response is exactly the string given.

· Substring mean that the pattern is a substring from the response.
· Not means than you won’t find the pattern in the response. It’s an error if so.

Size Assertion

Size assertions are uses to verify the size of the response of the server as a way to check the content. For example, do I send the right form when the client clicks the left button?
To do so, right click on the element you want to focus on, then Add->Assertions->Size Assertion. You will be ask to explain how big is supposed to be the answer,
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by filling the Size in bytes blank and the radio button’s Type of comparison appropriated.
Xpath Assertion
Xpath assertion are use to verify a DOM element is in the response. For example if you expect a table with pieces of information about customer appears on a page you can verify the table here indeed and that there are several rows in your table.

To do so, right click on the element you want to focus on, then Add->Assertions->Xpath
 Assertion.
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Then fill the text area provided for the XPath Assertion. The button Validate checks the syntax of your XPass field.
Xml Schema Assertion 

XML Schema is an XML-based alternative to DTDs. An XML Schema describes the structure of an XML document. The XML Schema language is also referred to as XML Schema Definition (XSD).
First store the xml response from the server with a “Save response to file” post processor as shown below:
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Then get the xml file from the bin directory and use the xml tool on http://www.hitsw.com/xml_utilites/  . On this page you get the schema from any xml file you want.
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This gives you this kind of result:
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Then right click add -> Assertions->XML Schema Assertion
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Fill the XML Schema file name field with the name of the file generated by the tool used above. Then run your tests. If the server response doesn’t match your schema you will be warned. Check the result tree out.
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Tip : You may have in your response some attribute xmlns. It will cause you some problems with html response sometimes, because the program shown above doesn’t take in count this attribute so you will have to add it by yourself in your “.xsd” file.
<xs:element name="html">

    <xs:complexType>

      <xs:sequence>

        <xs:element ref="head" />

        <xs:element ref="body" />

      </xs:sequence>

      <xs:attribute name="lang"  type="xs:NMTOKEN" use="required" />


  <xs:attribute name="xmlns:xsi"  type="s:string" use="optional" />

    </xs:complexType>

  </xs:element>
But when you will change for it another problem will come up. The name of the attribute can’t match with xmlns. So don’t use this type of assertion with html response.
Recording https requests and answer with Badboy

JMeter doesn’t allow recording https requests and answers. To do so I recommend you to download and install badboy on your computer. You don’t need to get the last version of this product. Actually a former version will be enough and overall free.

After installation just run badboy enter the address in the inner browser of badboy press the record button. It will act exactly as if you were using the http proxy server of JMeter.
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Then File -> Export to JMeter…
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Here you are you can now edit you scenario with JMeter, just by opening the .jmx file
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